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The Unisys GIF Tax
Work on this application was started some months before the surprise announcement by 
CompuServe and Unisys that Unisys held a patent on the compression algorithm used by GIF
files and would be demanding a royalty on commercial applications which use GIF files. The 
registration fee for this application includes a payment to Unisys. Note that the Unisys 
patent applies to software which reads and writes GIF files, not to the GIF files themselves. It
is our understanding that you are free to use files created or modified with this software in 
any form you choose without paying Unisys.



Introduction
GIF Construction Set for Windows is a powerful collection of tools to work with multiple-block
GIF files. It will allow you to assemble GIF files containing image blocks, plain text blocks, 
comment blocks and control blocks. It includes facilities to manage palettes and merge 
multiple GIF files together. It will make the extensions of the GIF specification work for you. 
Among its other functions, GIF Construction Set for Windows can:

- Create Netscape animations.
- Create transparent GIF files.
- Create interlaced GIF files.
- Add, edit and delete comment blocks.
- Add non-destructive text to images as plain text blocks.
- Create multiple-image GIF files
- Serve as a fully-compliant Windows GIF viewer application.
- Be a GIF viewer "helper" application for a World Wide Web browser or Mosaic client.

You can use GIF Construction Set for Windows to create and modify GIF files with as many 
blocks as you require.

GIF Construction Set for Windows requires a minimum of four megabytes of memory to run 
reliably, with eight megabytes preferable. Larger images may require more memory still.



Blocks in GIF Files
A GIF file usually consists of two blocks, to wit, a header and an image. However, the 
structure defined by the GIF 89a specification allows for GIF files which contain multiple 
images, and several additional optional block types. These types are:

- Comment blocks, which can include text describing the image in question, defining its 
creator or copyright status or anything else you want to say about it. Comment blocks are 
not displayed as part of a GIF file.

- Plain text blocks, which specify text to be overlaid on an image. The position and colour 
of the text can be defined. Unlike merely adding text to an image with a paint program, plain
text blocks don't damage the underlying image.

- Control blocks, which define image transparency and allow for user input. The 
transparency field of a control block will let you specify that one colour in an image or a 
colour used by the text in a plain text block is to be regarded as transparent by a GIF viewer,
allowing the underlying image to be visible wherever it occurs.

- Application blocks, which allow private application data to be included in a GIF file. 
Application blocks can't be created or edited with GIF Construction Set for Windows , 
although they will be preserved if you open a GIF file which contains them.

Every GIF file begins with a header block, which defines the size of the screen the GIF files 
should be displayed on if possible, and an optional global palette. It's important to 
understand how palettes work in GIF files. A palette defines the colours to be used by any 
images and plain text blocks in a GIF file. A global palette, defined by the header block of a 
GIF file, pertains to all the images in the file. Alternately, individual image blocks are 
permitted to have palettes of their own, called local palettes. 

Because most display devices are colour mapped, and can only work with one palette at a 
time, attempting to display multiple GIF images, each with its own local palette, will usually 
leave you with something that looks like bad abstract art or the aftermath of an all you can 
eat spaghetti dinner. As such, multiple image GIF files should have all their images 
referenced to the global palette of the file unless you have a compelling reason to do 
otherwise. GIF Construction Set for Windows includes facilities to remap and dither images 
to a global palette.

GIF Construction Set for Windows will let you open an existing GIF file or create a new one 
and add blocks, modify the various data fields of blocks and delete blocks. In the case of 
image blocks, it offers a number of image processing options to make assembling multiple 
image GIF files from a number of discrete images as practical as possible.



Running GIF Construction Set for Windows 
When you initially boot up GIF Construction Set for Windows , you'll see a list of all the GIF 
files in the \GIFCON directory of your hard drive. You can open a GIF file either by double 
clicking on one of the names in the list, or by selecting Open from the File menu. You can 
navigate to a different directory or drive either by double clicking on the drive and directory 
entries in the list of the GIF Construction Set for Windows application window or through the 
File Open dialog. 

If you click once on the name of a GIF file which has a Graphic Workshop thumbnail 
associated with it, you'll see a small version of the GIF file's first image in the application 
window of GIF Construction Set for Windows. Thumbnails will be discussed in greater detail 
later in this document.

When you open a GIF file, the main application window of GIF Construction Set for Windows 
will list each of the blocks in the GIF file, beginning with the header. Clicking once on an 
image block will display a thumbnail for it. Double clicking on any block that GIF 
Construction Set for Windows recognizes will call up a dialog to edit it. You can also edit a 
block by clicking on it once to select it and then clicking on the Edit button in the GIF 
Construction Set for Windows button bar.

GIF Construction Set for Windows does not allow application blocks or blocks of unknown 
types to be edited.



Editing the Header Block
You can modify the following fields of the header block of a GIF file:

- Screen width and screen depth: These are the dimensions in pixels of the screen the 
GIF file would like to be displayed on. They can be any value greater than zero. Note that the
screen dimensions do not affect the dimensions of images displayed from a GIF file, but they
may affect where on your screen the images are placed in a fully compliant GIF viewer.

- Background: The background is the colour of the area around the images to be displayed 
if the images in question don't fill your screen. The background is actually a number drawn 
from the current global colour palette... if the palette is changed, the actual colour displayed
may change too. To change the background colour, click on the colour button in the Edit 
Header dialog and select a new colour. The number in the Background colour button is the 
actual palette index being used.

- Global palette: The global palette flag tells GIF viewers whether a GIF file includes a 
global palette. If you change this flag, GIF Construction Set for Windows will look at the GIF 
file you're working on to see if there are images which expect a global palette and prompt 
you accordingly. In most applications of GIF files, it's desirable to have a global palette.

You can save palettes from GIF Construction Set for Windows to disk files and load them in 
as new global or local palettes. The size of the current palette is shown to the right of the 
Load button.

The Sorted flag of Edit Header box allows you to set the state of the sorted palette flag in 
the header of GIF files. This flag has no affect on how GIF Construction Set for Windows 
displays images... it may be of importance to other applications which read your GIF files.



Editing Image Blocks
The Edit Image dialog includes the following fields:

- Left and top: These fields determine where the image in question will be displayed on 
your screen relative to the upper left corner. The values are in pixels.

- Interlaced: This flag determines whether the image in question will be stored interlaced or
normally. If you have enabled the Display Interlaced item in the Setup dialog this will affect 
how GIF Construction Set for Windows displays images. It will also change how images 
appear in applications which display them one line at a time. Interlaced images are 
commonly used in World Wide Web pages. 

- Local palette: You can enable a local palette for any image block in a GIF file. By default, 
the palette for the image in question will be used. You can also load and save palettes, as in 
the Edit Header field. Be careful doing this... you might wind us with an image having very 
weird colours. The Load and Save buttons will only be active if you have switched on the 
local palette option. The number of colours in the current image palette will be displayed 
below the Local Palette switch.

The View button of the Edit Header dialog will display the image in question. Specifically, it 
will display it against a solid colour background -- grey by default -- with a set of purple 
guides indicating where the screen area defined by the screen width and screen depth fields 
of the current header block would fall. This assumes that your screen area and image are 
smaller than your screen. The background colour can be defined through the GIF 
Construction Set for Windows Setup dialog, discussed elsewhere in this document. 

Note that the View buttons in the edit dialogs will not display an entire complex GIF file. 
They'll only display the current block. If your image does not display correctly, please read 
the section of this document that deals with the About dialog for a discussion of Windows 
screen drivers. Hit Esc or click the right button of your mouse to exit the View mode.



Editing Comment Blocks
A comment block consists entirely of text. The Edit Comment Block dialog is a text editing 
window in which you can add, modify and delete the text of a comment block. Under GIF 
Construction Set for Windows , a comment block can include up to 32,767 characters.

The Format button of the Edit Comment Block dialog will toggle between displaying text in 
the conventional chunky Windows font and displaying it in a monospaced font. The former is 
better for editing a lot of text, while the latter is useful if you'd like to create formatted 
comment blocks.



Editing Plain Text Blocks
Plain text blocks consist of text and some information about how to display it. The text can 
be edited the same way comment block text is handled. The following fields define how plain
text blocks will be displayed:

- Text left and text top: These fields define where the text will appear on your screen, 
relative to the upper left corner of the viewing area. These values are defined in pixels.

- Grid wide and grid deep: These fields define a rectangle in which your text will be 
drawn. A grid ten wide and twelve deep would allow for twelve lines of up to ten characters 
each. Text which doesn't fit in the grid defined by a plain text block is not displayed.

- Cell wide and cell deep: These fields define the dimensions of the characters used to 
display text. In theory, a GIF viewer should look at these fields and create a suitable 
monospaced font to display the text in question. In most cases this is not so -- GIF 
Construction Set for Windows included. Most GIF viewers will use a font which is eight pixels 
wide and anywhere from eight to 32 pixels deep.

- Foreground and background: These are the colours used to display the text in question.
Note that if a plain text block is preceded by a control block which defines a transparent 
colour, one of these colours can become transparent.

- Block title: This is the text which appears in the main block list of GIF Construction Set. 
The Write Directory Block option in Setup must be On for this field to be active.

The View button will display the image preceding the plain text block being edited with the 
text in question superimposed over it. Note that the View buttons in the edit dialogs will not 
display an entire complex GIF file. They'll only display the current block. If your image does 
not display correctly, please read the section of this document that deals with the About 
dialog for a discussion of Windows screen drivers. Hit Esc or click the right button of your 
mouse to exit the View mode.



Editing Control Blocks
A control block includes the following fields:

- Transparent colour: If this switch is turned on, one of the global palette colours in 
subsequent image or plain text blocks will be regarded as being transparent by GIF 
Construction Set for Windows when you view a complete GIF file. This means that rather 
than displaying areas of this colour, it will allow whatever is underneath the displayed image
or text to show through. You can select which colour is to be transparent with the colour 
button to the right of this switch.

- Wait for user input: If this switch is turned on, a GIF viewer displaying your GIF file will 
display the next image or plain text block and pause for user input. User input is usually a 
key press or a mouse click.

- Delay: This is the number of seconds a GIF viewer will pause after displaying the next 
image or plain text block. If Wait for User Input is also enabled, the delay can be interrupted 
by a key press. 

- Remove by: This tells a GIF viewer what do with an image after it has been displayed. Be 
careful of the Previous Image option... some GIF viewers have problems with this if you ask a
really big image to be removed this way.

The View button will display the image preceding the control block being edited with any 
transparent effects that you've defined. Note that the View buttons in the edit dialogs will 
not display an entire complex GIF file. They'll only display the current block. If your image 
does not display correctly, please read the section of this document that deals with the 
About dialog for a discussion of Windows screen drivers. Hit Esc or click the right button of 
your mouse to exit the View mode.



Editing Loop Blocks
A loop block includes one field, to define the number of times the images in the GIF file in 
question will repeat. Note that a Loop block will always appear as the second block in a GIF 
file, no matter where you insert it. Only one Loop block can appear in a GIF file.



Inserting Blocks
You can add blocks to a GIF file with the Insert button of the GIF Construction Set for 
Windows button bar. A dialog will appear to allow you to select the type of block you wish to 
insert. Inserted blocks are always inserted immediately after the currently selected block. 

If you attempt to insert an image block into an existing GIF file, a dialog will appear 
prompting you for the file to insert. Images can be drawn from files in the following formats:

PNG: These are compressed graphics created to replace GIF.
MacPaint: Monochrome image files from Macintosh systems
GEM/IMG: Primarily used by Ventura Publisher
PC Paintbrush PCX: The native file format of Z-Soft's PC Paintbrush software
CompuServe GIF: Among the most widely used PC image file formats
Deluxe Paint/Amiga IFF/LBM: Only supports pure IFF files and Deluxe Paint LBM files 
PC Paint Pictor PIC: Supports them all, including high colour PIC
Truevision Targa: Supports all Targa files
Windows /OS2 BMP/DIB: Supports all BMP files, including those from OS/2
Windows 3 RLE: Supports most Windows RLE files
Microsoft Paint MSP: This is the old monochrome paint format from Windows 2
Halo CUT: This is the very obscure Halo cut format
PFS:First Publisher ART: Only supports uncompressed ART files
JPEG JPG: All JPEG files will be displayed in 256 colours
Sun Raster RAS: These are files from Sun unix workstations
HRZ SSTV: These are high colour slow scan television files
WordPerfect Graphics WPG: Only supports bitmapped WPG files. If your WPG files do not import they are 
vector files, and are not supported by GIF Construction Set for Windows .

Note that if you import an image from a GIF file using the Insert function, the first image in 
the file will be read, even if the file actually contains multiple images. Use the Merge 
command of GIF Construction Set for Windows, discussed later in this document, for an 
alternate approach to importing images from GIF files.

If you attempt to insert an image which has a different palette from the current global 
palette of your GIF file, a dialog will appear asking how you'd like to handle the new image's 
palette. These are the available options:

- Use a local palette for this image. If you do this, no colour shifts or dithering effects will
be introduced into the image, but very nasty things may happen if you attempt to display 
this image concurrently with other images in the file. You can't use plain text blocks with 
local palette images. Local palettes are usually not a very good idea for conventional display
applications. If you attempt to import a true colour image with this option, it will be dithered 
to a 256-colour image internally.

- Use a local grey palette for this image. The image will be converted to grey scale and 
installed with a local palette. All of the foregoing considerations for local palettes still apply.

- Remap this image to the global palette. This is a good choice for mechanical images...
drawings and such... and a really bad choice for photographs. Each colour in the source 
image will be replaced by the closest match from the global palette. This will usually make 
photographs look posterized.

- Dither this image to the global palette. This is a good choice for photographs. It will 
give you the best colour match... and usually the most attractive results... with a slight loss 
in detail resolution.



- Use this image as the global palette. This option will only be available if no other 
image blocks currently exist in your GIF file, such as when you create a new file. The global 
palette for the header of the file will be drawn from your imported image. If you attempt to 
import a true colour image with this option, it will be dithered to a 256-colour image 
internally.

- Use it as is. No checking or correction will be performed, and the colours in your imported 
image will fall where they may. This option is useful if you know that certain colours in your 
imported image correspond to colours in the current global palette, such as for images 
created to be overlays with transparent colours. Plan on radical colour shifts and Andy 
Warhol's worst nightmare if this is not the case.

If you insert other types of blocks... specifically control, comment or plain text blocks... 
default blocks will be created which you can subsequently edit, as has been discussed.



Managing Blocks
The Manage function in the Block menu will let you globally change the Control blocks in 
your GIF files. It's useful for adding lots of Control blocks at one time, deleting lots of Control 
blocks without wearing your mouse down to a puddle of molten plastic and for changing the 
characteristics of lots of Control blocks.

Depending on the options you select, the Manage function's file selector will deal with Image
or Control blocks. Specifically:

Insert Before Selected Images: This option will insert a new Control block before each of 
the selected Image blocks.

Insert Where Required: This option will insert a new Control block before each of the 
selected Image blocks which is not presently preceded by a Control block.

Set All Existing Controls: This option will change the parameters of each of the selected 
Control blocks. Note that this pertains to all control blocks, even if they precede Plain 
Text blocks, rather than Image blocks.

Delete Selected Controls: This option will remove all the selected Control blocks. No 
other blocks will be affected.

Image Block Position options: This section allows you to set the Left and Top fields of all 
the selected image blocks. If you enable the Absolute option, all the blocks will be set to 
the values specified in the two spin button fields. Otherwise, the left and top values will 
be incremented by the values in the spin button fields, beginning with the left and top 
values for the first selected block.

Note that if you click on the titles for the spin button fields when the Absolute switch is 
not enabled, they'll change, allowing you to decrement the initial values as well. These 
fields cannot have values less than zero.

Note that you can only select Control and Image blocks in the file selector list for the 
Manage function. You can select multiple items in this dialog    hold down Ctrl and click on 
multiple items, hold down Shift and click on the beginning and then on the end of a range of 
items or hold down your mouse button and drag it over a range of items.



Merging Blocks
The Merge button in the GIF Construction Set for Windows main window will allow you to 
import all the blocks in a GIF file... except for the header block... into the current file. They 
will be inserted starting just after the currently selected block. Image blocks will be handled 
using the same logic discussed previously for inserting individual image blocks... a dialog 
may appear prompting you to choose a strategy for handling palette conflicts.

You can use the Merge function to import selected images from a multiple-image GIF file. 
Merge the whole file and delete the blocks you don't need.



Extracting Blocks
The Extract feature in the GIF Construction Set for Windows File menu will allow you to select
one or more blocks in an existing GIF file and have them written out to a new GIF file. GIF 
files created by Extract must contain at least one Image block    the Save button will not be 
active until at least one Image block is selected. The Header block will automatically be 
adjusted to define a rectangle that encloses the images in the extracted file. The other 
parameters of the new Header block will duplicate those of the source Header block.



Deleting Blocks
You can delete any block save for the header by selecting it and clicking on the Delete 
button, or by hitting Del. Note that once a block is deleted, it's gone for good.



Viewing GIF Files
The View button in the main window of GIF Construction Set for Windows will display a GIF 
file using a fully compliant viewing function. The viewing area, as defined by the screen 
dimensions of the file header, will be centred in the main window of your screen if it's bigger 
than your screen. Each displayable block will appear in the order it's defined in the GIF file. 
You can terminate the display any time you like by clicking the right button of your mouse or
hitting the Esc key.

The background of the view mode may appear dithered on systems with colour mapped 
screen drivers. This can be changed using the Setup dialog of GIF Construction Set for 
Windows, as discussed elsewhere in this document.

If the screen dimensions defined by a GIF file's header block are greater than the dimensions
of your screen, scroll bars will appear to allow you to pan over the displayed image.



Exporting GIF Files
The Export function in the File menu will create a new, single-image GIF file which contains 
all the display elements of a multiple image GIF file. It will export what you would see on 
your screen if you were to click on View. Note that it will ignore image blocks which would be
removed to the background image.



Creating New GIF Files
To create a blank GIF file, select New from the File menu. A blank GIF file always includes a 
header block. You can add blocks to a new GIF file with the Insert and Merge functions.



Opening and Saving GIF Files
Any GIF 87a or 89a file can be opened into GIF Construction Set for Windows. Files created 
with GIF 87a headers will be converted internally to GIF 89a files. As discussed previously, 
you can open a GIF file either by selecting the Open item from the File menu of GIF 
Construction Set for Windows or by double clicking on the name of a GIF file in the main list 
of the application window. It's possible that extremely complex GIF files... those with lots of 
blocks... may not open completely. See the section of this document dealing with the Setup 
dialog for information about getting around this.

The Save and Save As functions of the File menu will save your current GIF file to disk. All 
GIF files written by GIF Construction Set for Windows will have GIF 89a headers. 

If you enable the Write Thumbnail option of the Save As dialog, each file written by GIF 
Construction Set for Windows will be accompanied by a thumbnail. Thumbnails are stored in 
files with the extension .THN. As such, the thumbnail for PICTURE.GIF would be called 
PICTURE.THN. The thumbnails created by GIF Construction Set for Windows are compatible 
with those used by Graphic Workshop for Windows and other Alchemy Mindworks 
applications which support thumbnails. 

Thumbnails will appear in the application window of GIF Construction Set for Windows if you 
select a GIF file prior to opening it. A thumbnail always represents the first image in a 
multiple-image GIF file.

Unregistered copies of GIF Construction Set for Windows will add a comment block to any 
GIF file you save. This comment block will not appear once you register GIF Construction Set 
for Windows.



Cutting, Copying and Pasting Blocks
You can cut or copy the current block of a GIF file to the Windows clipboard using the 
appropriate items of the Edit menu. A block copied to the Windows clipboard will have its 
block structure stored as hexadecimal data defined in OEM text. Plain text and comment 
blocks will have their text stored as conventional Windows text. Image blocks will have their 
image information stored as conventional Windows device-independent bitmaps.

It's a really bad idea to mess with the OEM text objects copied from GIF Construction Set for 
Windows and then paste them back into GIF files.

You can copy a bitmap from another application onto the clipboard as a device-independent 
bitmap and paste it into a GIF file through GIF Construction Set for Windows. It will be given 
an image block on the way in, which you can subsequently edit if you like.



Closing GIF Files
If you select the Close item of the File menu of GIF Construction Set for Windows, the current
GIF file will be closed and the list in the main application window will revert to showing you 
the names of all the GIF files in your current directory. Opening a new GIF file automatically 
closes the current one.



The Setup Dialog
The GIF Construction Set for Windows Setup dialog can be called up through the Setup item 
of the File menu. It includes the following fields.

Display Interlaced: If this switch is enabled, image blocks with interlaced images will 
appear in interlaced order.

Draw Frame Guides: It this switch is enabled, purple guides will appear to define the 
image area of a GIF file being viewed using the View buttons of the edit dialogs. Guides do 
not appear in the main View function.

Use Image Offsets: If this item is not enabled, images will be displayed centred on your 
screen, rather than where the position fields of their image blocks say they're supposed to 
be. There are few good reasons for doing this.

Dither View Background: This item is ignored on systems with screen drivers that can 
display more than 256 colours. If your current Windows screen driver can display 256 or 
fewer colours, setting this switch on will cause the background of the main View mode to be 
dithered to approximate the setting of the background field of the header block of the GIF 
file being displayed. Setting it off will cause the closest match from the current global palette
to be used, allowing for Window's somewhat funky palette management strategy. See the 
section of this document which deals with the About dialog of GIF Construction Set for 
Windows for information about how to determine the number of colours your current 
Windows screen driver can display.

True Transparency: If this item is enabled and you're using a Windows screen driver with 
better than 256 colours, you'll see transparent GIF files displayed correctly. If it's disabled -- 
or if you have a sixteen- or 256-colour Windows screen driver installed in your system -- GIF 
Construction Set will use Windows' GDI calls to handle transparency, which are less than 
wholly reliable. They are somewhat faster, however. If you find the length of time it takes GIF
Construction Set to display transparent elements in GIF files excessive, try disabling this 
feature. This switch will be ignored if you have a sixteen- or 256-colour driver installed.

Dither Contrast and Dither Brightness: These values only affect monochrome dithering 
in the image block import function. If you attempt to import a colour image into a 
monochrome GIF file, it may be dithered to two colours, depending on the palette option you
select. These fields can be used to fine tune the dithering.

Interlace Delay: This is the number of milliseconds GIF Construction Set waits after it 
display one line of an interlaced image.

Maximum blocks: When a GIF file is opened in GIF Construction Set for Windows, a fixed 
number of blocks will be allocated for it. If you exceed this number, no new blocks will be 
accepted. The default value, 255, will suffice for all but the most complex GIF files. You can 
increase this number if you run out of blocks or if GIF Construction Set for Windows refuses 
to open a very complex GIF file because it has more than 255 blocks. Note that changes to 
this field will not take effect until the next time you open or create a GIF file. If you run out of
blocks you must save your current GIF file, change this field and open the file again. 

Setting the Maximum Blocks field higher than it needs be will tie up excessive memory and 
probably slow down Windows and applications running under it.

Default Palette: This item sets the initial palette size for the header of blank GIF files 
created with the New function of the File menu. There are a number of palette options:



256 colours: This palette has an even dispersal of colours between black and white.

256 colours with grey: This palette has an even dispersal of colours between black and 
white, but it includes 32 levels of grey.

216 colours/Netscape: This is the palette Netscape uses to remap colour images to for a 
256-colour machine. This should be the default palette setting for creating photorealistic 
GIF files for use with Netscape.

32, 64 and 128 colours: These are evenly dispersed palettes. The 32-colour palette is a 
bit deficient in blues.

16 colours: This is the sixteen-colour Windows palette.

2 colours: This palette includes all the colours of the rainbow, provided they're black and 
white.

Adjust Header on Save: If this item is enabled, GIF Construction Set will calculate the 
correct Screen Width and Screen Depth values for every GIF file it saves to disk. It's a really 
good idea to let it do this.

Check Animations: If this item is enabled, GIF Construction Set will analyze GIF files which 
have more than one image as it saves them to disk and warn you if they contain elements 
that might cause problems under Netscape. You can ignore these warnings for non-animated
GIF files. The EXAMPLE.GIF file that comes with GIF Construction Set will set off lots of 
warnings if you attempt to save it to disk    this is nothing to be concerned about, as it's not 
an animated GIF file.

Registration name: You can turn a shareware copy of GIF Construction Set for Windows 
into a registered copy by entering your name in the registration field and clicking on Accept. 
A dialog will appear prompting you for the key word provided with your receipt for 
registration. Make sure you type in your name and key word exactly as it is on your receipt --
case and punctuation matter.

Once you have successfully registered GIF Construction Set for Windows, you will no longer 
see the beg notice when the application terminates and the extra comment block added 
when you save a file will not appear. In addition, you'll have great karma and our leather 
winged demon of the night won't regard you as a handy source of protein... something well 
worth considering.



The About Dialog and Windows Screen Drivers
The About button in the button bar of GIF Construction Set for Windows will display a beg 
notice for unregistered versions and a grey dialog with a unicorn for registered versions. The
latter dialog will also tell you several useful things about your computer, such as the amount
of memory Windows thinks is free and the number of colours your current Windows screen 
driver can display without dithering. The latter is very important... if you attempt to view a 
256-colour GIF file on a system with a sixteen-colour driver installed, the resulting images 
will look posterized and ugly. This does not mean that GIF Construction Set for Windows is 
misbehaving... you must update your Windows screen driver to see 256-colour images 
correctly. 

If you have an unregistered copy of GIF Construction Set for Windows, you can see the latter
dialog by holding down the shift key and clicking on the Ok button in the beg notice dialog. 
You should do this if you are not seeing 256-colour images displayed correctly to check if the
problem is with your screen driver.

As an aside, this works the other way, too... should you have reason to wish to see the 
unregistered beg notice dialog after you've registered, hold down the shift key and click on 
the Ok button.



Secrets, Tricks and Common Applications
Here are a number of useful things you might want to know about using GIF Construction Set
for Windows.

Creating transparent GIF files: A transparent GIF file is one in which an image block 
displays with one transparent colour. Anywhere the transparent colour exists in the image, 
no pixels will be painted and whatever was visible before the image appeared will show 
through. To create a transparent GIF file, add a control block before the image block you 
wish to include transparent areas. Enable the Transparent Colour switch in the control block 
and set the transparent colour to correspond to the colour of the areas of the image you 
wish to appear transparent. 

Note. Read this. Very important. Definite demon bait if you don't. Transparent GIF files only 
display with their transparent elements under fully compliant GIF viewers. This includes GIF 
Construction Set for Windows, most World Wide Web Browsers and a limited number of 
other GIF viewing applications. Most applications that just display pictures will ignore 
transparency information in GIF files. This includes our own Graphic Workshop software, for 
example. If your transparent GIF files don't seem to be transparent in some applications, the
problem is not with GIF Construction Set for Windows or your GIF files. 

Creating magic graphic logos: You can create a GIF file that has a main image and a 
smaller secondary logo which appears, sticks around for a moment and goes away. In 
addition to the main image block, you will need a control block followed by a smaller 
secondary image. The secondary image can have a transparent background... this looks very
slick. Set the control block up with whatever transparent colour you require, a brief delay, 
the user input flag turned on and the Remove By field set to Previous Image.

Creating plain text with a drop shadow: This looks very slick. It involves two plain text 
blocks and two control blocks. Each of the plain text blocks should contain the same text. 
The second one should be slightly lower and to the right of the first one... two pixels in each 
direction is usually about right. The second and optionally the first plain text block should be
set up so their background colours are transparent, as defined by their control blocks.

Automatically viewing an image when it's loaded: Hold down the shift key when you 
double click on a GIF file name in the main application window of GIF Construction Set for 
Windows and the image will be loaded and then immediately viewed.

Using GIF Construction Set for Windows as a GIF viewer for other applications: If 
you run GIFCON.EXE, the executable file for GIF Construction Set for Windows, with the path 
to a GIF file as its command line argument, it will automatically load the indicated file just as
if you'd explicitly loaded it by clicking on it from the main application window. If you 
append /V to the file name, it will automatically load and view the file. If you append /V/Q to 
the file name, it will load the file, view it and then quit back to the calling application as soon
as you hit Esc or click with the right button of your mouse. You can prevent it from quitting in
this situation by holding down the shift key when you exit the view mode. 

GIF Construction Set for Windows makes a powerful GIF viewer for World Wide Web 
browsers.



Contacting Alchemy Mindworks Inc.
You can contact us by mail by writing to us at:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
L0G 1A0
Canada

We will attempt to answer questions from unregistered users who write to us to the extent 
that their answers are needed for you to fully determine whether this software will suit your 
requirements. 

You can reach our technical support line by phone... see the section of this document which 
deals with technical support.

We can also be reached through the Alchemy Mindworks bulletin board. It's available twenty-
four hours a day at 1-905-936-9503. As of this writing, the protocol was 300, 1200 or 2400 
baud, or 9600 baud v.32bis, eight data bits, no parity and one stop bit. 

The bulletin board always has the most recent versions of all our shareware on it, plus bug 
fixes, drivers and other relevant information. It only exists to support Alchemy Mindworks' 
shareware... it does not have a general file area.

If you encounter problems with a file, you're welcome to upload the errant file to our bulletin
board. Actually, you can upload any picture files you like to the board... we enjoy getting 
pictures.

If you have a question about GIF Construction Set for Windows, feel free to leave it on the 
bulletin board. We try to answer all questions within twenty-four hours. Note that you must 
call back to retrieve your answer... please don't ask us to phone you or to leave the answer 
on another bulletin board.

Our CompuServe address is 70451,2734. Our Internet e-mail address as of this writing is 
alchemy@mail.north.net. We will at our discretion answer reasonable questions by e-mail. 
Please do not leave credit card information on the Internet.

You can find the current version of GIF Construction Set for Windows and our other 
applications on the Internet at our FTP site ftp.mindworkshop in the directory 
/pub/alchemy.

You can download current versions of our applications, keep up to date with version changes
and find other interesting bits at our World Wide Web server 
http://www.mindworkshop.com

We ask that in contacting us you appreciate that we are a small company with limited 
resources. If you have not registered this software we will not tell you to go to hell, but 
please don't ask us for half an hour of free technical support. We have not built the price of 
technical support into the cost of GIF Construction Set for Windows, as few users require it. 
We believe very strongly in not making everyone pay for something that only a small group 
needs. If our various governments felt the same way, our various economies wouldn't be in 
the midst of melting down.



Support this Software
If you like GIF Construction Set for Windows and find it useful, please register it. This will 
allow you to shut off the begin notice which appears when you exit GIF Construction Set for 
Windows. More to the point, though, it'll make you feel good. We've not infested GIF 
Construction Set for Windows    with excessive beg notices, crippled it or had it verbally insult
you after ten days. We trust you to register this software if you like it.

If you want to see additional features in GIF Construction Set for Windows, support it. If we 
had an Arcturian mega-dollar for everyone who has said they'd most certainly register one 
of our applications if we'd add just one more thing to it, we could buy ourselves a universe 
and retire.

Finally, should you fail to register this software and continue to use it, a leather winged 
demon of the night will tear itself, shrieking blood and fury, from the endless caverns of the 
nether world, hurl itself into the darkness with a thirst for blood on its slavering fangs and 
search the very threads of time for the throbbing of your heartbeat. Just thought you'd want 
to know that.



Technical Support
Technical support is available at 1-905-936-9501, 10:00am to 5:00pm EST most business 
days. If you encounter our answering machine... it does happen occasionally... please try 
back later. One of the considerations in offering very low cost software is that we 
are unable to return calls for technical support.

Callers who are rude, abusive or pig-headed with our technical support staff will wind up as 
demon-chow. See the section on Supporting this Software

Please do not call our 800 number for technical support. The people who answer our sales 
line can put a credit card machine into warp drive, but they know less about software than 
most cats know about quantum mechanics.

We are also happy to provide you with technical support by e-mail, as discussed earlier in 
this document.



Legal dogma
Neither the author nor Alchemy Mindworks Inc. assumes responsibility for any damage or 
loss caused by the use of these programs, however it comes down. If you can think of a way 
a picture program can cause you damage or loss you've a sneakier mind than any of us.

All the registered trademarks used herein are registered to whoever it is that owns them. 
This notification is given in lieu of any specific list of trademarks and their owners, which 
would not be as inclusive and would probably take a lot longer to type. 

If you register GIF Construction Set for Windows , we will assume that you are doing so 
having tested the shareware version and ascertained that it's suitable for your hardware and
requirements. We cannot provide refunds for shareware registration if you subsequently 
change your mind.

The JPEG reader in IFMT.DLL is based on code from the Independent JPEG Group. Parts of the 
TIFF reader in IFMT.DLL is based on code by Sam Leffler.

GIF is a trademark of CompuServe.

GIF Construction Set, QuickShow, Multimedia Workshop for Windows, Pagan Daybook, 
Graphic Workshop, GraphSaver, Desktop Paint, Image Gallery and GrafCat are trademarks of
Alchemy Mindworks Inc.

Shareware stuff -- if you have downloaded GIF Construction Set or had it given to you on disk
to try out, we invite you to play with it for as long as you like to ascertain whether it's what 
you need. This shareware is not crippled, nor will it suddenly stop working after a 
predetermined period of time. At such time as you feel it's useful enough to do productive 
work, we ask that you register it. Using GIF files created by GIF Construction Set in your web 
pages constitutes productive work. If you don't think it's worth registering, please simply 
delete this software and any files you created while you were evaluating it.

Rumour has it that the leather-winged demon of the night trolls the web looking for GIF files 
that include unregistered GIF Construction Set comment blocks and rips the lungs out of 
their owners. Of course, this is just a rumour.



Creating Banners
Banners are GIF files which contain text. This can be simple text    that is, a single image GIF 
file with words painted on it    or it can be an animated GIF file with text which
scrolls from right to left.

Banner text can be painted with one of three effects:

Simple: the text is painted in the foreground colour against the background colour.

Shadow: The text is painted in the foreground colour against the background colour 
with a shadow in the shadow colour.

Embossed: The text is painted as an embossed object in the foreground colour against 
the background colour.

Banners always use the current default palette, as set in the GIF Construction Set Setup 
dialog. Changing the default palette resets the colours in the Banner dialog. Also, note that 
only the Simple text option is available if the two-colour default palette is selected.

The Rolling option determines whether a banner will be a single static image or a sequence 
of images in which the text appears to move from right to left. Note that rolling banners with
large fonts can create very large GIF files.

The Cells option determines the number of frames in a rolling GIF banner.

The Delay option sets the number of 100ths of a second between cells for a rolling banner.

The Loop option determines whether a rolling banner will repeat indefinitely or only display 
once.

The Offset control sets the offset in pixels between text and its drop shadow or the size of 
embossed text. Banners with a drop shadow of one or two pixels and a a drop shadow colour
of black or another very dark colour look pretty cool.

The Font button selects the font to be used in creating a banner.

The Transparent Background option sets the background colour to be transparent for the 
banner you're creating. This effect won't really be visible in the Test mode, as the default 
background of your GIF file will be the same as the background colour    banners with 
transparent background will appear as such in web pages.

The Foreground, Background and Shadow colour buttons set the colour values to be used in 
creating banners.

The Test button will let you preview your banner.

The Sample Text window will show you the font size and colours for your banner    drop 
shadow and emboss effects will not appear in this window.



Creating Transitions
Transitions are single image GIF files which have been augmented with special-effect 
transitions to make them appear and disappear in interesting ways. To create a transition, 
begin by selecting the source image with the Select button. Note that Transition doesn't 
modify your source image    it creates a new copy of it.

Transitions with large source images can create unworkably large final GIF files. Be careful 
how you use this feature if you're creating images for web pages.

Here are the current special effects supported by the Transitions feature: 

Adam Seven Interlace: This will display your image one pixel at a time, in complex 
interlace order. This effect simulates the interlacing used by PNG files.

Horizontal Split: Your image will appear in two sections, with half rolling in from the left
of your frame and half rolling in from the right.

Sandstorm: Your image will appear one pixel at a time, in random order.

Tile: Your image will appear in small squares, in random order.

Vertical Split: Your image will appear in two sections, with half rolling in from the 
bottom of your frame and half rolling in from the top.

Wipe in From Bottom: Your image will roll in from the bottom of your frame.

Wipe in From Left: Your image will roll in from the left side of your frame.

Wipe in From Right: Your image will roll in from the right side of your frame.

Wipe in From Top: Your image will roll in from the top of your frame.

The Select button will allow you to choose the source image for your transition. Source 
images can be in any of the file formats GIF Construction Set supports for import.

The Cells option determines the number of frames in a transition.

The Delay option sets the number of 100ths of a second between cells for a transition.

The Loop option determines whether the transition will repeat indefinitely or only display 
once.

The Transparent Background option sets the background colour to be transparent for the 
transition you're creating. This effect won't really be visible in the Test mode, as the default 
background of your GIF file will be the same as the background colour    transitions with 
transparent background will appear as such in web pages.

The Remap to Default Palette option will cause your source image to be adjusted to use the 
currently selected default palette, as configured in the Setup dialog. This may result in 
noticeable dithering artifacts if your source image has already been dithered once, but it 
improves Netscape's colour reproduction for 256-colour systems.

The Background colour button sets the background to be used in creating transitions.

The Test button will let you preview your banner.



The Pause After Cycle option causes a transition to pause when it has completed its image, 
and before it begins to remove it. The pause also occurs after an image has been completely
removed if the Loop option is enabled. The duration of the pause is set by the Pause spin 
button.

The Appear and Disappear options determine whether your transition will include an 
appearing sequence, a disappearing sequence or both. One or both options must be 
enabled.

Note that you can modify transitions once they've been created and opened in GIF 
Construction Set, just as you would other animated GIF files. For example, you can combine 
different transitions by merging a file with just the Appear phase enabled with one having 
just the Disappear phase enabled.



Converting Movies to GIF Files
GIF Construction Set for Windows will convert an AVI video clip file into an animated GIF file. 
There are two possible catches to using this feature -- GIF files so created can get very large,
and may take a while to create. The latter will be especially true if your source AVI file has a 
lot of frames, or frames with relatively large pixel dimensions. Ten- megabyte AVI files aren't 
uncommon -- ten megabyte GIF files are not well regarded as adjuncts to web pages.

To convert an AVI file to GIF, select Convert Movie to GIF from the File menu of GIF 
Construction Set for Windows. Select a source AVI file. A dialog will appear to let you choose 
a colour management strategy for your GIF file. Here are the choices and what they mean:

Dither to the Netscape 216-colour palette: This will preserve the photographic quality 
of a photorealistic movie if it's viewed on a machine running Netscape and a 256-colour 
driver. This is technically the safest choice for movies which will be displayed in web pages --
it will introduce some dithering into your movies, but it will avoid radical colour shifts even 
on cheap computers from Sears.

Remap to the Netscape 216-colour palette: This is technically the best choice for line 
art movies, such as those created by digital animation software, if you want them to look 
right in web pages which might be displayed by 256-colour machines.

Dither to the 256-colour orthogonal palette: This will do a slightly better job of 
dithering movies, especially 24-bit movies, than the Netscape 216-colour palette option. At 
least, it will if your movies will be displayed on a machine with a 32,768-colour or better 
screen driver. Machines with 256-colour drivers will cause Netscape to introduce some colour
shifts into movies with this palette.

Remap to the 256-colour orthogonal palette: This uses a slightly larger palette for line- 
art movies. It will give you slightly better results for movies shown on a machine with a 
32,768-colour screen driver or better, and slightly worse results for 256-colour machines.

Use source image palette: This option makes no attempt to adjust the source palette of 
the movie being converted, and it doesn't dither anything. This will unquestionably produce 
the best-looking results for movies to be displayed by GIF Construction Set's View mode and 
by Netscape for machines with 32,768-colour screen drivers or better. Machines with 256-
colour drivers will probably introduce some colour shifts into movies converted with this 
option. Life's a bitch this way. This option is also vastly quicker than the previous four, as it 
doesn't have to process each frame of the source image. You can't use this option with 24-
bit source movies.

All of the foregoing notwithstanding, you should probably use the source image palette 
option unless you have a good reason for doing otherwise. The resolution of most movie files
at the moment isn't all that impressive as it is, and introducing dithering into them will 
noticeably degrade them. Plan to experiment with this a bit.

Note: Converting movie files to GIF files can create a lot of blocks. Plan on two blocks per 
frame, plus at least a header and possibly a loop block. If you encounter memory or block 
access errors during conversion, increase the Maximum Blocks value in Setup and try it 
again. A good start for Maximum Blocks is 1024.



Creating Wide Palette GIF Files
Wide palette GIF files can only be created by the 32-bit version of GIF Construction Set.

The Wide Palette GIF File option will let you create GIF files which can display more than 256 
colours. This probably sounds much more useful than it really is -- while it genuinely works, it
embodies some serious catches. Before you use this feature, please take a moment to 
understand what it's up to so you don't wind up bashing your head against a wall in 
frustration.

A GIF image can only store a maximum of 256 colours. However, a GIF file can store any 
number of images. If each image has its own local palette, it's possible to have more than 
256 different colours stored in the file.

This is what wide palette GIF files do. If the source image you wished to store in one had 510
distinct colours, GIF Construction Set would create a GIF file with two Image blocks. The first 
Image block would have a local palette with the first 255 colours of your source image in it. 
The second Image block would have a local palette with the second 255 colours from your 
source image. Each palette would also have one colour that did not appear anywhere in your
source image, to be used as a transparent colour.

In discussing wide palette GIF files, the Image blocks that your source image will be split into
are called "panes".

The actual images would be constructed such that those pixels of your source image which 
appeared in their palettes would appear in the images in question, and the transparent 
colour would appear everywhere else.

When such a GIF file is displayed, the first Image block will take care of the first 255 colours, 
and the second Image block will take care of the second 255 colours. Because the "unused" 
pixels are transparent, the two frames would essentially be merged when the display was 
completely updated, with the result that 510 distinct colours would be displayed.

In practical terms, a 24-bit source image must be "quantized" to derive a suitable list of 
colours, that is, a large palette must be derived from it based on the dispersal of source 
colours. The Wide Palette GIF function of GIF Construction Set lets you select how large this 
palette can get.

Wide palette GIF files allow you to enjoy lossless images having lots of colours in a format 
which is compatible with existing web browsers. However, they embody some important 
catches, as follows:

- Wide palette GIF files tend to get large, as they require that a single 24-bit image be split 
into multiple 256-colour images, each of which must be stored separately.

- While Netscape, Explorer 3.0 and GIF Construction Set will display wide palette GIF files 
correctly, almost nothing else will. This includes most GIF viewers and paint packages.

- If a wide palette GIF file is displayed on a system running with a 256-colour screen driver, it
will look really awful.

- Wide palette GIF files cannot include transparency, as they use transparent colours for 
their own purposes. They could in theory be animated, if you wanted to push the envelope, 
but the results would be very, very slow and quite ugly.

- Netscape does occasionally refuse to display GIF files with local palettes if it's really 



starved for resources, and some of its betas have been known to crash under these 
conditions. Be warned.

Wide palette GIF files are created through the Wide Palette GIF option of the edit menu of 
GIF Construction Set. Here's what its options do:

Maximum number of colours: This sets the maximum possible wide palette size. If your 
image turns out to have fewer distinct colours than this, the palette may get smaller. As 
each pane in a wide palette GIF file can hold a maximum of 255 colours -- plus one 
transparent colour -- this also defines the maximum number of panes.

Interlace: If this option is enabled, the pane images of your wide palette GIF file will be 
written interlaced. This looks really slick in GIF Construction Set, but it will typically have no 
effect in Netscape, which does not display interlaced images as interlaced when they occur 
in multiple image GIF files.

Add Initial Sketch Image: If this option is enabled, the panes of your wide palette GIF file 
will be preceeded by a fairly coarse sixteen-colour version of the image, which will 
eventually be wholly overwritten by the following panes. It's something to look at in the 
mean time, however. Turn this feature off if you want to create slightly smaller GIF files. The 
sketch image ignores the Interlace option, and is always non-interlaced.

Sorted Palette: If this option is enabled, the wide palette created by the Wide Palette GIF 
function will be sorted, such that the brightest colours appear first, and turn up in the first 
panes. If it's not enabled, the palette colours will appear randomly. This won't affect how 
your wide palette GIF images look when they're finally displayed, but ti does affect what 
they look like as they're being built up on your screen. This is especially true if you enable 
the Interlaced switch.

Select: Use this button to load a source image. Source images must be stored as 24-bit files
-- that is, as true-colour BMP, JPG, TGA, PCX and PNG files, and other suitable formats. You 
cannot use a GIF file as the source for the Wide Palette GIF function.

Test: This feature will test a wide palette GIF image. Considering the time it takes to create 
one of these things, you might want to skip the Test function.

Click on OK to create a wide palette GIF file. This feature takes a fairly long time to run -- it 
can be aborted by clicking anywhere within the GIF Construction Set window. When it's 
complete, your wide palette GIF file will have been opened in the main list box of GIF 
Construction Set. Click on View to see what it looks like -- mind the earlier warning that it will
look pretty ugly on a system with a 256-colour screen driver.

By default, the background colour of a wide palette GIF file will be white -- you can change 
this by editing its Header block. This doesn't matter to a web browser, which ignores the 
background colour values in GIF files.

Select the maximum colour size carefully. More colours will produce much better looking 
final images, but they'll also create much larger final GIF files.

Note: If you save a wide palette GIF file, open it into GIF Construction Set and 
then save it again -- for example, to add a comment block to it after the fact -- 
you will probably see some animated GIF warnings. Ignore these -- they're valid 
warnings, but wide palette GIF files are designed to break some of the rules for 
well-behaved web page animations.



Creating Animated GIF Files
GIF Construction Set for Windows offers two approaches to creating animated GIF files. You 
can use the Animation Wizard feature of the File menu, or you can create animated GIF files 
by hand. The former is much easier and will not create animated GIF files which are wildly 
inappropriate for use with Netscape and other web browsers. The latter will avail you of 
much more control over the animated GIF files you create.

Keep in mind that animated GIF files created with Animation Wizard can subsequently be 
edited in the main window of GIF Construction Set.

Note that Animaton Wizard will allow you to import images from most popular 
bitmapped file formats. You will enjoy much better results if you import your 
source images from a 24-bit format, such as BMP, PCX, PNG or JPG, rather than 
from GIF files. Note also that Animation Wizard only imports images -- it does not 
include transparency information from your source files.

Using Animation Wizard
The Animation Wizard feature of GIF Construction Set for Windows will walk you through 
creating an animated GIF file. It offers fewer options than you'd have if you were to create 
an animated GIF file from scratch, but it's dead easy to use. It will prompt you for 
information about the animation you want to create, assemble all the necessary blocks and 
finally open the file in GIF Construction Set's main window. You can edit it further, or just 
save it to disk.

To create a GIF file with Animation Wizard, simply select this feature from the File menu of 
GIF Construction Set for Windows and follow the prompts. You can fine tune your GIF file 
after it has been created by Animation Wizard. The most important questions are:

Do you want to create an animated GIF file for use in World Wide Web Page? If 
you answer Yes to this question, Animation Wizard will choose a palette for your GIF file 
which is optimally compatible with Netscape Navigator.

Are the images for your GIF file photorealistic or drawn? Photorealistic images are
scanned graphics and computer generated art which has gradients. Anything that looks 
as if it might have started life as a photograph should be regarded as photorealistic. 
Drawn images are graphics with hard lines, such as text and line art. Draw images with 
sixteen colours are text and line art which are constrained to use the default Windows 
palette, that is, graphics with very few colours.

Especially if you're new to using animated GIF files in a web page, it's a really good idea to 
start with Animation Wizard.

Creating Animated GIF Files by Hand
You can create animated GIF files by hand in GIF Construction Set for Windows    this 
approach is more time consuming, but it will give you more control over how your animated 
GIF files look and behave.

It's also noble as hell, of course    hard stuff always is.

Here's how to do it:

1. Check the Setup dialog to make sure you have an appropriate default palette. For 
animated GIF files to be used on the web, this should be either the sixteen-colour Windows 
palette or the 216-colour Netscape palette. Other palette options will work, but they may 
produce less attractive images in a web page viewed on a 256-colour system.



2. Select New from the File menu.

3. Click on Insert and select Image.

4. When the Open dialog appears, select the image files that will appear in your animation. 
You can select more than one file at a time by holding down the Ctrl key and clicking on each
file in turn, or by selecting the first file to be part of your animation, holding down the Shift 
key and then selecting the last file. Click on OK when you're done.

5. When the Palette dialog appears, select Dither to Global Palette if your source images are 
photorealistic or Remap to Global Palette if they're drawn. Enable the Use This Selection for 
Subsequent Images item. Click on OK.

6. When all your images have been inserted, click on Insert and select Loop if you want your 
animation to loop continuously. Note that as of this writing, the Iterations counter of a Loop 
block is ignored by Netscape. All animated GIF files with Loop blocks will loop forever.

7. You must insert a Control block in front of each Image block in your GIF file. The easiest 
way to do this to select Manage from the Block menu. Click on Select All and enable the 
Insert Before Selected Images item. Click on Apply. A dialog will appear to let you set the 
parameters of your new Control blocks.

You should set a Delay value    this varies with the intended speed of your animation. 
Netscape's animation drivers are a bit machine-dependent as I write this    absolute speed 
settings are largely impractical. Start with something around 100. You can change this later 
with the Manage function.

If you'll have transparent elements in your GIF file, you should set them now, as discussed 
elsewhere in this document.

The Remove By option should be set to Nothing if your GIF files are all the same size, have 
no transparent elements and will overlay each other perfectly, or to Background otherwise.

Click on OK when you're done.

8. Your animated GIF file is complete. Click on View to see what it looks like, and on Save As 
to save it to disk. Note that Netscape's animation playback runs at anywhere from five to ten
times faster than real time    as of this writing, it's usually necessary to make animated GIF 
files run artificially slowly under GIF Construction Set to get them to run at something like 
the right speed in Netscape. Also note that the Background value in
the Header block of your GIF file defines the background colour for the View feature
under GIF Construction Set    it's ignored by Netscape.




